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Distribution Advantage 

Distribution Advantage is a collection of tools for advanced warehouse and distribution teams. The module 
consists of: 

On-Demand Purchase Orders, which provides an assisted form of creating Purchase Orders directly from 
Sales Order information. On-Demand checks the individual Sales Order lines, and can either "soft-allocate" 
current free stock, or raise individual or consolidated Purchase Orders by supplier. This contrasts with the 
forecast-based Purchase Order function in Exo Business, which reorders stock for items that are below a 
minimum threshold up to a preset level. 

Batch Sales Order Line Processing, which uses task definitions to set selection criteria and processing 
actions. This includes processing of release, pick, supply and invoice quantities. This function differs from 
the Batch Sales Order processing function in Exo Business, in that it allows processing at a Sales Order line 
level rather than by discrete orders. 

Stock Transfer Requests, which you can use when enhanced stock transfers are required. This includes 
when request then dispatch then receipt-type processes are required, or when transferred stock is in-transit 
for a period of time such as when being transferred via courier. Stock Transfer Requests can also produce 
transfer record documentation. 

Sales Order Consolidation, which consolidates orders based on picked (but unsupplied) quantities. Supply 
and invoicing may then proceed for the consolidated orders. This function may be used (as a separate 
processing step) with other Sales Order functions including Batch Sales Order Line Processing. The 
consolidation also uses tasks to predefine selection criteria. 
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On-Demand Purchase Orders 

The ‘On-Demand’ function is designed to assist in automating the production of purchase orders to supply 
specific sales orders or jobs.  Industry terms such as ‘procure’ orders or ‘back to back’ orders may be used 
to generally describe this type of process.  Distribution Advantage could also be appropriate in a true 
indent-ordering scenario. 

The default mode of operation effectively groups sales order lines that have not been previously ordered, 
and raises a purchase order (per supplier) with one consolidated purchase order line per product 
line.  These orders can effectively be generated continuously with very little user intervention. 

The scope of this module is limited to assisting the creation of purchase orders and is not intended to 
provide complete back-to-back function or other automated supply chain management.  The end user 
should be aware that any changes forced by customer or supplier changes after purchase orders have been 
created will not automatically change the status or quantities of those purchase orders.  This process must 
be handled manually outside this program. 

A scan process constructs a drillable pro-forma set of data. Products are tagged to their main supplier (as 
set on the stock item) but may be manually moved to an alternate supplier (and another purchase order). 
Quantities cannot be amended directly on this form.  An ‘Order’ button is used to action each supplier 
order, allowing the selection of which orders will be placed.  Basic purchase order header information is 
entered as part of this procedure. 

Built-in selection criteria allows a product range to be defined for the scan, and custom selection criteria 
can be added by way of user-defined purchase groups (including SQL script filtering). 

An alternative mode of operation allows stock to be ‘soft allocated’ against the sales orders. Once all stock 
on hand has been allocated, a second run can be performed to create top-up purchase orders for the 
remaining sales orders for which stock was not ‘soft allocated’.  This feature could be used if the intention 
is to use a buffer stock holding, or to automatically ‘use up’ previously returned stock in the warehouse. 

On-Demand vs. Forecast Purchase Orders 

On-Demand purchases contrasts to other methods available in MYOB Exo Business for generating purchase 
orders. ‘Manual’ purchase orders simply allow a single purchase order to be raised, and the items manually 
selected. ‘Forecast based’ purchase orders are used to raise a purchase order against a selected supplier 
(for products normally purchased from that supplier), to ensure stock levels are always above minimum 
threshold levels. 

End-User Scenarios 

The following scenarios illustrate possible uses of the Distribution Advantage module. 

Fresh goods supply 

"Our customers are restaurateurs. They place orders for fresh seafood, fresh salads up to 12.30 for delivery 
late afternoon/or early following morning. We want to email a single consolidated purchase order to each 
supplier, our Seafood and our fresh Salad Supplier at 12.45 and at 4.30pm. We 'poll' (or scan) for 
outstanding sales orders manually twice per day." 

Effectively many sales orders to one purchase order. 
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Portal, Virtual Warehouse, Ship-Direct (charge-through) orders 

"We have a large product range but hold no stock. Our customers order products via a web site. We need 
to organize supply as quickly as possible. Therefore as each Sales order is entered we wish to have a distinct 
purchase order created and emailed (faxed) for each supplier. We have the order-polling feature set to poll 
automatically every 3 minutes. Each purchase order contains the delivery address of the sales order 
customer and the goods are shipped direct. The supplier invoices us (with proof of delivery) and we invoice 
the customer." 

Effectively one sales order to many purchase orders. 

Viewing Statuses 

To control and indicate the sales orders that have been processed by this module, Distribution Advantage 
maintains a status code per line within the sales orders. It also updates the corresponding purchase order 
number of the sales order lines. This information can be exposed on the line periscope of the sales orders 
form using extra fields. A status code is also updated to the purchase order lines. These status codes may 
be used for selective reporting if multiple ordering processes are used. 

On-Demand Purchase Orders Setup 

On-Demand purchase can be customised to provide for basic workflow function when integrated into other 
applications. 

Note: The following steps are normally undertaken during MYOB Exo Business configuration and 
setup carried out by an Exo Business partner. 

A facility is also provided to form purchasing groups to allow the filtering of sales orders by specific groups 
debtor accounts – that may or may not be directly be the normal debtor account grouping. 

General Setup 

On-demand Purchase Orders utilises status codes in the sales and purchase order lines to determine the 
status of the sales order, and indicates the source of the purchase order. It also provides selection criteria 
to identify new sales order lines to be processed. 

To configure On-Demand Purchase Orders, select Setup > General Setup from the On-Demand Purchase 
Orders window: 
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Note: By default, most of these options are set correctly during installation. Normally these settings 
only need to be altered if custom functions are to be created.   

Supply sales order lines with statuses in the range  These fields specify the range of sales order line statuses 
to search for. The status is set to zero when a new sales order is entered. 

As an example, setting the range to 0-9 may be appropriate if other utilities need to manipulate the sales 
order before being made available to automatically order. 

If a purchase order is generated 

Set the purchase order line status to  Designates the status code updated to the generated purchase 
orders. This can be used for selective reporting against purchase orders 

Set the sales order line status to  Designates the status code updated to the participating sales order lines 
when a purchase order is generated. The status code must be non-zero and not within the range specified 
by Supply sales order lines with statuses in the range, so Distribution Advantage flags these lines with this 
status so that they are omitted from future runs, otherwise they will be continuously reordered. This status 
can also be used for selective reporting against Sales Orders. 

If include stock 

The following will occur when the Mark from stock process is selected. 

Supply out of stock in locations  These fields designate a range of locations to scan for stock availability, 
from which stock can be "allocated" to this order. 

Set sales order statuses to  Designates the status code that will be updated back into sales order lines if the 
stock is to be offset against stock-on-hand.  The status code must be non-zero and not within the range 
specified by ‘Supply sales order lines with statuses in the range’, so Distribution Advantage flags these lines 
with this status so they are omitted from future runs.  Please note that this has no effect on the stock file, 
and is only a nominal association. 
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Set the bin code on the sales order to  When the module creates a purchase order the purchase order 
number is updated to the bin field within the sales order lines.  If offsetting against stock an alternate 
designation can be defined as a constant here. This should be alphanumeric to distinguish it from a 
purchase order number.  It would be advisable for the particular string to indicate that a stock offset was 
implied. 

Notes 

• During the purchasing process, the purchase order number is stored in 
SalesOrd_Lines.PurchOrdNo. Selective reporting against the sales order can be used to determine 
which sales order lines are associated with each purchase order. This may provide the basis of an 
action list for manual follow through after receipting the purchase order. 

• Distribution Advantage retains a one-way link from the sales order line to the purchase order (but 
not the other way around). To determine which sales orders are tagged to a given purchase order, 
selective reporting against the sales order lines is required. 

• Orders supplied from stock are designated by marking the sales order line with a unique sales order 
status and bin code, as explained in the following section. This allows custom reports to be run, or 
the sales order to be printed out with this allocation information attached, ready for picking. 

• The specific value of the sales order status also designates that the sales order lines are considered 
offset against stock. This can be used for selective reporting. 

Purchase Groups 

Purchase groups allow for the definition of custom selection criteria when scanning for orders to purchase. 
This provides the ability to perform the order run in groups — for example, running "urgent orders" first. 

Consider the following when setting up purchase groups: 

• This selection could apply to customer or product centric fields. 

• Only one Purchase Group can be selected in any given run. 

• Lookup items are automatically excluded from purchasing. 

Note: The configuring of purchase groups requires the entry of database-level SQL statements, and 
is normally configured by your Exo Business partner. Only the actual SQL selection criteria 
needs be specified when entering the purchase group SQL statement (that is, do not specify a 
full SQL WHERE statement).   

To configure On-Demand Purchase Orders, select Setup > Purchase Groups from the On-Demand Purchase 
Orders window: 
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On-Demand Purchase Orders - General Operation 

The order process is performed in two phases: selecting the items to order, and then raising the actual 
Purchase Order or allocating from stock. 

Selecting Items to Order 

The items to order are selected in the main On-Demand Purchase Orders window. 
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This main screen of On-Demand Purchase Orders determines the items to be ordered, and how the stock 
items for the Sales Orders will be processed. The following filters are available: 

• Select Groups filters the range of stock items in this selection process. Select a stock group 

range with the From and To stock group fields, and if used, select a predefined Purchase 

group 

• Select Sales Orders filters the Sales Order to be processed; select all Sales Orders, orders 

from a specific customer, or a selected Sales Order. 

• Select the Process Mode required; whether to create Purchase Orders by supplier or by 

Sales Order, or mark items as being supplied from stock-on-hand. 

The Process Mode determines whether stock is ordered by Purchase Order, or allocated from stock. 
However, the general operation of using On-Demand Purchase Orders is the same for all modes of 
operation. 

To start an On Demand Purchase Order run: 

1. Once the filters and process mode have been selected, the details of the orders can be viewed by 
clicking the Refresh button. This will refresh the list of supplier accounts that have stock 
requirements outstanding on Sales Orders, filtered by the Groups and Sales Order selection criteria. 

2. Click the Forward button, or double click on a line to drill down to a product list screen for that 
supplier. (The Back button in the toolbar returns back to the supplier list, if required). 
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Note: additional options may be displayed in this window, depending on the process mode selected 
previously. 

3. If details of the supplier are required, click the Show Supplier button on the toolbar. This opens the 
standard Creditor Account Details screen from Exo Business, to allow the full creditor details to be 
viewed. 

4. To view the details of the stock item, select the line with the stock item required and click the Show 
Stock button from the toolbar. This will pop up the standard Stock Item Details screen from Exo 
Business, to allow the full stock item details to be viewed. 

5. To see the actual Sales Orders that make up the purchase, click the Forward button or double click 
on the stock item. This will bring up a list of the Sales Orders that have been grouped for this item. 
If required, double click the Sales Order item to drill to display the actual Sales Order. 
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6. Click the Back button to return to the previous window, ready to process. 

7. Click the Back button again to return to the main On-Demand Purchase Order window, ready to 
select the supplier to use. 

Purchase Order Per Supplier 

If one Purchase Order per supplier is to be raised, then the Per Supplier Purchase Mode should be used. 
This will consolidate all outstanding Sales Order lines for that supplier, and raise a single Purchase Order 
against that supplier. 

To create a Purchase Order per supplier: 

1. Select the Sales Orders to process. 

2. Select Per Supplier for the Process Mode. 

3. Click Refresh to update the list. 

4. Double click  a supplier to view the order details, ready to raise the Purchase Order. Alternatively 
select the supplier and press the Forward button. 

5. To raise a Purchase Order for these items, click the Process button. The following window displays: 
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6. Enter the relevant details and click OK. The Purchase Order is raised. 

Purchase Order per Sales Order 

If separate Purchase Orders are required for each customer Sales Order (to allow a one-to-one supply of 
Purchase Order to Sales Order), then the Per Sales Order Purchase Mode should be used. 

As well as raising a separate Purchase Order against a supplier per customer, the delivery address on the 
Purchase Order is marked with the delivery address of the client for direct shipping. This allows direct 
supplier to customer delivery. 

To create a Purchase Order per Sales Order: 

1. Select the Sales Orders to process. 

2. Select Per Sales Order for the Process Mode. 

3. Click Refresh to update the list. 

4. Double click the supplier for which Purchase Orders are to be raised against. Alternatively select 
the supplier and press the Forward button. This displays the stock items waiting to be ordered 
against this supplier: 



MYOB EXO Business Distribution Advantage 

11 

 

5. Select the Edit details option to edit each Purchase Order’s header information as the order is 
generated. 

6. As multiple Purchase Orders may be raised during this process, you can control the frequency of 
printing out and emailing each Purchase Order. Select the preferred Print Options and E-mail 
Options. 

7. To begin raising Purchase Orders, click the Process button. 

8. If the Edit details option was selected, the following prompt will appear to allow the Purchase 
Order header details to be edited, including overriding the Sales Order delivery address that is 
copied to the individual Purchase Order. 
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Enter the relevant details and click OK. 

9. Purchase Orders are created, and the opportunity to print or email will be provided, depending on 
the setting of the Print Options and E-mail Options. 

10. On completion of all Purchase Orders, a list of all Purchase Order numbers raised displays. 

Mark from Stock 

Marking a Sales Order as "take from stock" is a simple check to see if existing stock on hand could be used 
to fulfil the order. The marking from stock does not allocate stock, or reserve stock. Therefore it is not 
sensitive to cumulative allocation of stock in this list. 

While this function is simple in operation, it may be useful in sites to ensure any stock on hand is 
specifically checked first before fresh stock is purchased. 

Selecting stock will mark the Sales Order lines with the bin code and Sales Order line status as defined on 
the General Setup window. Set the Bin Code on the Sales Order field. This prevents these being 
"purchased" using this program during the next purchasing run. A custom report can then be run to view 
the Sales Order lines that should be checked and supplied from stock on hand. 

To check Sales Order lines against stock on hand: 

1. Select the Sales Orders to process. 

2. Select Mark from stock for the Process Mode. 

On-Demand Purchase Orders - Other Functions 

Moving to a Different Supplier 

By default, items are shown again the main supplier of that item, as defined in the main stock screen for 
that stock item. If it is preferred to purchase that item from another supplier (for example, for out of stock 
or pricing issues), then you can "push" this item to another supplier. 

All items against a supplier can be transferred to a different supplier, or a single item against a supplier can 
be moved to a different supplier. 

To move all items against one supplier to another supplier: 
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1. From the On-Demand Purchase Orders window, select the line to be moved to an alternate 
supplier. 

2. Click the Transfer Supplier button. Or right click on a supplier line to open a pop-up menu, and 
select the Transfer to another supplier option. A Supplier Transfer dialog displays: 

 

3. Enter the alternate supplier to push the order to. Enter part of the supplier name and press TAB, or 
enter ? and TAB to search for a supplier name. 

4. Click OK. All items against the original supplier will then appear against the new supplier. 

Tip: To defer ordering a product, you can move it to another supplier for which an order is not 
actioned. Dummy supplier accounts such as "Need to find another supplier" or "Purchase 
under dispute" could be created for this purpose. 

To move a single item to another supplier, simply drill down from the original supplier, and right click on 
the stock item you wish to move to another supplier. The process is then similar to that of moving all items. 

Auto Refresh 

In some purchasing situations it is desirable to leave the On-Demand screen open continuously, and have 
Distribution Advantage periodically refresh the list automatically. 

To automatically refresh the order list, select Setup > Auto Refresh from the On-Demand Purchase Orders 
window: 

 

Select the Refresh Every option, and enter the amount of time between refreshes, in minutes. Click OK to 
close the window. 

To disable auto refresh, select the Disable option. 

Note: It is still possible to manually refresh the list in Auto Refresh mode, by clicking the Refresh 
button on the main toolbar. 
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Batch Sales Order Line Processing 

Batch Sales Order Line Processing (BSOLP): 

• Provides a view of sales order lines that is not constrained by sales order number 

boundaries. Lines in a batch can be from multiple sales orders and can also be a subset of 

lines on those orders. 

• Allows pre-definition of each of the Tasks in the process. Standard tasks for the common 

workflow processes are configured in the database by default. Exo Business implementers 

and administrators and may also create customised Tasks to suit the client's needs. Tasks are 

tagged with a user profile, which you can use to control staff members they are available to. 

• Provides enhanced functions for automatically populating quantity fields from a number of 

different free stock calculations. You can automate them within the Task definition. 

• Optionally allows grid style manipulation of quantities across the entire batch facilitating 

user intervention. This can be useful if you need best fit refinement following suggested 

Free stock calculated quantities or if you only need to enter figures. 

• Optionally shows additional breakdown of stock level information for the stock item of a 

sales order line. 

You can: 

• Release Stock for Backorders (Backorders Only) Print Picking Documents 

• Release Stock to unreleased orders (all outstanding orders) Print Picking Documents 

• Confirm Picked quantities on Orders currently in picking Print Picking Confirmation 

• Supply all Picked Order lines and print Packing Slips 

• Invoice all as supplied Print Invoices 

Task Definition 

You can customise, clone, or change Standard Tasks. You can also create additional custom tasks to 
establish variants. 

Select a pre-defined task when creating a batch of sales order lines to process. Task definitions specify the 
criteria applying to three basic steps in processing a batch: 

• Selection criteria to build a list of participating sales order lines. 

• An action list to apply to the selected lines that automatically sets quantities to process 

(optional). 

• The transactional process and printing functions required when the Process button is clicked. 

Use a wizard to: 

• Select orders from a single location (all or single location) 

• Select orders of a particular status (statuses are defined by Distribution Advantage and are 

not user definable). 

• Select orders with a specified combination of outstanding quantity types (for example, 

combinations of has backorders, has unreleased, has unpicked, has unsupplied, and/or has 

uninvoiced). 

• Select orders from branches (multiple select). 

• Select order lines containing specific stock items (multiple select). 
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• Exclude order lines for stock items that are serial tracked, batch tracked, part of a kit, and/or 

are a lookup item. 

• Select order lines with stock from specific primary suppliers (multiple select). 

• Select orders relating to specific sales people (multiple select). 

• Select orders for specific customers (multiple select). 

• Select orders within a specific range of due dates. A date range measured in days relative to 

today’s date are specified in the task set up and then resolved to actual start and end dates at 

run time. Quick select options are also available for ranges Today and Overdue. 

Use action codes to set quantities for Backorder, Release, Pick, Supply and Invoice. You can base them on 
calculation methods for free stock or a preceding quantity in the workflow – for example, Invoice as per 
Supply. 

The process functions determine whether or not to process quantities for Release, Pick Supply, and/or 
Invoice and to print their corresponding documents. 

Constraints 

Quantity constraints 

The BSOLP function applies quantity constraints to ensure a subsequent step is not processed with a 
greater quantity than the step preceding it. 

When processing a negative sales order quantity (credit) Distribution Advantage does quantity comparison 
by taking absolute value to ensure that less than tests are applied. 

Within the batch-processing grid, any cell that does not comply with the constraint rules will be highlighted 
by a red background colour and an error message defining the exception condition displays on the status 
bar. The user will be inhibited from processing the batch (using the Process button) whist there are any 
cells with exceptions. 

Bill of Material constraints 

BOMs of type Build are always excluded from the BSOLP process.  Builds require that all lines (components 
and output item) be processed as a group (i.e. as an embedded works order).  The restriction exists to avoid 
partially processing a build when the selection criteria may include only some of the component lines 
within the build. 

This restriction does not apply to BOMs of type Kit or Template. A Task may optionally exclude Kits as part 
of its selection criteria. Template lines are treated as ordinary lines. 

Serial and batch numbered items 

As these require additional information to be supplied they may also be optionally excluded as part of a 
Task’s definition. 

Provision exists in the grid to key batch numbers on sales order lines appearing within the batch, however 
there is no provision to split lines where multiple batch codes may be required for a single sales order line. 
No provision exists to key or alter batch code expiry dates. These dates are determined from the pre-
existing batch being consumed. 

Serial numbers display a selection window for each sales order requiring serials.  This can significantly 
increase the required user interaction with Distribution Advantage when pressing the Process button. 
Excluding serialised items or pre-assigning serial numbers should be considered if the number of 
participating serialised orders would otherwise be high. 
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Setting Up Tasks 

When Distribution Advantage installs to a database Distribution Advantage creates some default tasks for 
each of the possible steps in the workflow. In a simple business environment where additional filtering by 
customer, product location and the like is not required it is likely Distribution Advantage can be successfully 
operated with the default tasks provided. 

One of the advantages offered by Batch Sales Order Line Processing is the ability to create additional tasks 
to customise the distribution workflow for an organisation and/or individual user or workgroup within that 
organisation. Tasks can be created from scratch or copied from an existing task and modified.  This section 
explains the properties of a Task and how to create and amend tasks. 

Note: Tasks are also used by the Sales Order Consolidation process. Distribution Advantage creates 
one default task for this purpose. 

To set up Tasks, click the Setup Task button on the main Batch Sales Order Line processing window. 

When first selected the Setup Batch Task function displays a search screen of existing tasks. 

  

There are two sets of default tasks provided for use with Batch Sales Order Line Processing: 

• The set with filters operating at a sales order line level are marked active and appear by 

default when creating a batch. 

• The set with the filters operating at sales order header level is marked as inactive and are 

hidden by default when creating a new batch.  These can be activated if required. 

These tasks can be edited but MYOB recommends that they be left as default and copies be used for 
change if customisation is required. 

A task performs three basic functions: 

• Select - This determines lines to be included in a new batch. The criteria are established 

using a wizard. If necessary the resulting SQL can be edited. 
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• Actions - These are optional and may be used to automatically set quantities after batch 

creation. 

• Process - Determines what will be processed and printed when the Process button for the 

batch is used. The task defaults defined here may be altered for the batch at run time. 

In the task setup screen separate tabs exist for each of these functional areas. When creating a new task, 
the Select wizard is launched automatically. 

Creating a Task 

You can copy the default Tasks on the Setup Tasks window and use them as the basis of Tasks. Or, you can 
create a new task. 

Copying a Task 

To copy a task, select a Task  and click the Copy button. Distribution Advantage creates a Task in the search 
grid with the words Copy of added at the start of the name. You can edit the task. 

Creating a Task 

To create a task, click the New button. This screen displays: 

 

Enter information in these fields: 

Field Description 

Task Name 
The name of the task. This name displays when selecting the task to 
use when creating a batch. 

Default Batch Name 
Enter a name to use when creating a batch. Each time you create a 
batch, Distribution Advantage appends the batch number to it. 

User Profile 
This defaults to All. The task is available to anyone who can access 
Batch Sales Order Line Processing.. You can select a user profile to 
restrict the task to specific users. 
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Stock to Use 

Select the stock calculation to display and use as default when running 
a batch of this task. The stock status bar this also defines the default 
action when you click the taskbar buttons Release, Pick, Supply and 
Invoice. 

Sorting Order 

This field controls the order in which the tasks appear in the search 
window when creating a batch. 

You can leave this field empty. 

Apply to  
This field defaults to Batch Creation, but you can change it to Order 
Consolidation. 

Active   
Deselect this option to prevent the task being used when creating a 
batch. 

  

Before you can save a task, use the wizard to add selection criteria to filter the Sales Order lines that are 
when you create a batch. To do that: 

  

1. Run the wizard by clicking the Wizard button or click the Select tab. The Task wizard runs. 

2. Select the stock location - all locations (the default) or a single location. Click Next. 

 

3. Select the Sales Order Statuses to filter by. Order statuses are used when filtering by sales order 
header as opposed to sales order lines. Order statuses are defined and maintained by Distribution 
Advantage and are not user definable. 
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If filtering is required click Select to display a list of stock items. To select multiple statuses hold 
down the CTRL key and click multiple lines, then click Select & Close. Click Next to move to the next 
wizard screen. 

4. Select Sales Order Lines. This is usually mutually exclusive with the previous Sales Order Statuses 
step. Usually one or the other is used. 

 

To use any of these filters select the Select when sales order line option. The other checkboxes 
then become active provided their corresponding profiles are also active. These filters utilise a 
logical AND, in that all selected conditions must be true for the sales order line to be included. 

• Has Backorders - selects when the lines back order quantity is non-zero. 
• Has Unreleased - selects when the lines unreleased quantity is non-zero. 
• Has Unpicked - selects when the line has released quantity that is not yet picked. 



Batch Sales Order Line Processing 

20 

• Has Unsupplied - selects when the lines released quantity (or picked if active) has 
not yet been supplied. 

• Has Uninvoiced - selects when there is quantity supplied but not invoiced. 

Note: The filters in this step do not apply to the Sales Order Consolidation process, as consolidation 
always looks for picked but unsupplied. Settings at this step are ignored during consolidation. 

Click Next to proceed to the next step. 

5. Select Branches. By default, orders from all branches will be included in the order process. 

 

To restrict the order batch to specific branches click Select to display a list of branches. To select 
multiple branches hold down the CTRL key and click multiple lines, then click Select & Close. Click 
Next to move to the next wizard step. 

6. Select Stock Codes. By default, all stock codes will be included in the order. 
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To restrict the order batch to specific stock items click Select to display a list of stock items. To 
select multiple items hold down the CTRL key and click multiple lines, then click Select & Close. 

The Select Stock Codes screen has an additional option: Only with physical stock. Select this to 
exclude items that have no On Hand stock. The screen also has an Exclude panel. The options in this 
panel may be used to exclude items that are serial or batch tracked, are part of a kit, or are lookup 
items. Serial or batch numbered items require additional information and hence more manual 
input. 

Click Next to move to the next wizard step. 

7. Select Suppliers. By default, all suppliers are included. 

 



Batch Sales Order Line Processing 

22 

To restrict the order batch by supplier, click Select to display a search window of suppliers. To 
select multiple suppliers hold down the CTRL key and click multiple lines. The grid may be sorted by 
clicking column headings. Click Select & Close. The selected list will show the appropriate 
descriptions of the selected accounts. 

Click Next to move to the next wizard step. 

8. Select Salespeople. By default, all salespeople are selected. 

 

To restrict the list of orders by salespeople, click Select to display a search window of salespeople. 
To select multiple salespeople hold down the CTRL key and click multiple lines. Click OK to close the 
Select Salespeople dialog. 

Click Next to move to the next wizard step. 

9. Select Customers. By default, all customers are selected. 
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To restrict the list of orders by customer, click Select to display a search window of customer 
accounts. To select multiple accounts hold down the CTRL key and click multiple lines. Click Select 
& Close. The selected list will show the appropriate descriptions of the selected items. 

Click Next to move to the next wizard step. 

10. You can restrict the order list to a limited range of order due dates (not order placement dates). 
Dates specified here relative to an unknown "today's date” and actual dates are resolved when the 
task is run. 

 

Select one of the following options: 

• Any - No date selection will occur. 
• Today - This will resolve to Distribution Advantage date at run time and include due 

dates for that single day. 
• Overdue - At run time this will any due dates before Distribution Advantage date at 

run time. 
• Custom range - This allows a range of dates either side of the run date to be 

specified. Select the number of days relative to the run date to set a date range. At 
run time this value will be used to calculate an actual date relative to the run date. A 
value of zero represents today. Positive numbers represent future dates and 
negative numbers represent past dates. 

Click Next to move to the next wizard step. 

11. The last stage of the wizard presents a summary of the selection criteria: 
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Click Finish to save the wizard result in the Task template. The summary information will now also 
be shown in the Select Summary area of the Details tab. 

Entering Selection Criteria Manually 

The SQL WHERE clause resulting from the Task Wizard displays on the Select tab. For users with SQL skills, 
this tab provides the capability to add criteria not encompassed by the questions within the wizard. 

To edit the selection criteria manually: 

1. Click the Select tab to reveal the current selection criteria: 

 

2. Click the Edit button to enable editing for the SQL shown. If customising the SQL then it is 
recommended that you extend the WHERE clause after the (1=1) line. 

3. Click the Test button to execute the SQL SELECT statement containing this clause to verify it will 
run. 
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Note: Table aliases must be used when referencing database fields.  These are documented in the 
yellow information panel at the bottom of the screen. 

Actions 

Actions specify the batch-level functions to be run once the batch has been created. If quantities are only 
entered manually then no actions need be specified. It is usual practice to select at least one action to set 
quantities as a starting point. 

To set up actions, click the Actions tab: 

 

The available actions on the left are the same actions offered on the dropdown menus of the toolbar 
buttons Release, Pick, Supply and Invoice. Actions provide a way of automatically activating these buttons 
when creating a batch. 

Use the Add, Remove or Remove All buttons to add or remove actions from the right hand list. 

Note: Actions do not apply to the Sales Order Consolidation process. 

Process Defaults 

This tab is used to set the process settings that will be offered as default when the Process button is clicked 
within a batch. The defaults may be overridden when processing an individual batch. 
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Lock controls at Runtime  Select this option to prevent users overriding these settings at run time. 

Process to  The checkboxes in this panel designate the database activity that will be performed. 

Print documents  The checkboxes in this panel designates which documents will be printed in association 
with the selected Process to: functions. For some tasks you may not wish to print a document associated 
with the database activity — for example, you may wish to update the database with released (authorised) 
quantities but not print individual picking slips per sales order. 

Note: The Clarity form BSOLP_PICKSLIP.CLF is used rather than the PACKSLIP.CLF that is used by the 
Sales Order Supply screen. This allows for the format of picking documents to be different, if 
required. 

Invoice Date as Sales Order  Select this option to have the invoice date set to the order date of the sales 
order. 

Force to fully processed  This is usually only set with supply and invoicing to force the order to complete as 
part of the processing function. 

Print labels  This can be set to optionally print labels for each sales order line. The control will only be active 
if the Clarity document SOLINE.CLF exists. 

Dispatch Method  Select the dispatch method override if you require to preset a dispatch method. A 
dispatch method may then be selected from the list. 
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Note: The profile setting Dispatch Information Prompt must be enabled before this setting can be 
defined and used. Dispatch methods must also be set up in the Exo Business Configuration 
Assistant at Administration > Couriers > Dispatch methods. 

Note: Process Defaults do not apply to the Sales Order Consolidation process. 

Preprocess SQL 

The Preprocess SQL tab allows users with SQL skills to enter SQL statements to be performed before any 
other batch processing takes place. 

Creating a Sales Order Batch 

To create a batch: 

1. Select Batch Sales Order Line Processing from the Transactions menu. 

2. Click New to create a batch using a predefined Task. The first screen of the wizard displays: 

 

3. Select a task. 

A summary displays showing the selection criteria applied. The summary also shows a result count, 
indicating how many rows are in the batch. 
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4. Change the name of the batch and  and click Continue. The batch is created. This may take a while 
if the Result count is large. 

Note: If the Result count is zero, the Continue button is disabled. You can't create the batch with this 
criteria. 

5. If actions are specified in the Task, Distribution Advantage executes them.. A message displays to 
indicate they were performed and the batch displays: 

 

Note: The profile setting Sales Orders Release Quantity Enabled determines if the Release button is enabled and 
the Release column in the grid are enabled. 

The profile setting Sales Orders Pick Quantity Enabled determines if the Pick button is enabled and the Pick 
column in the grid is available. 

These profiles both default to disabled. 

Alternative Batch Creation 

You can create batches from a list of Sales Orders rather than using a Task. You must run actions from the 
toolbar or right-click menus. Or, you must enter quantities for the batch. 
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Tip: You can also run this process for a single sales order by passing a parameter from a command 
line and add it as a custom button to the Exo Business Sales Order screen. 

To generate a batch from one or more selected sales orders: 

1. Select New > Batch from Sales Order(s). A list of Sales Orders displays: 

 

2. Select a sales order or select multiple sales orders by holding down the CTRL key and clicking 
multiple lines. 

3. Click Select & Close to create the batch. 

The Batch Details Window 

The Batch Details window is where a batch of Sales Order lines is manipulated. 

When a batch is created or recalled, the Batch Sales Order Line Processing screen displays. 
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1. Main Grid 

The main grid shows the sales order lines in the current batch, as selected based on the criteria specified in 
the task that created the batch. 

There are a large number of columns available in the main grid (via the Select visible columns function of 
the grid), and viewing these within the grid may require horizontal scrolling. 

Most of the available columns available are read only (denoted by yellow background shading) The editable 
columns (normally un-shaded) will depend on profile settings but may include order, backorder, release, 
pick, supply and invoice quantities for each line. Stock batch codes may also be entered if active. 

The cells for Order No, Acc, and Stock Code may be double clicked to drill to the Sales Order, Debtor 
Account and Stock Item screens respectively.  These drill functions are also selectable from the right click 
menu.   

2. Toolbar and Menu bar 

The toolbar contains buttons for functions that operate on all rows of the grid. For more details see section 
Using the Toolbar. Some of these functions compute quantities into the grid.  These functions are also 
available to operate on a single grid line by using the right click menu function on that line (see section 
Using the sale Order Line Detail Grid). 

3. Stock status bar 

The stock status bar shows stock information for the currently selected grid line. The On Hand information 
is for the item/location associated with this line. 

4. Stock information panel 

Click the  button on the toolbar to toggle display of this panel. 
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The top row shows stock quantity information for the current location. 

• On Hand - This is the stock level on hand. It changes when a sale stock transaction occurs. 

For sales orders On Hand stock is consumed when quantity is processed from the Supply 

column. Supplying also reduces the Committed quantity by the same amount the computed 

Uncommitted quantity remains unaltered by the supply process. 

• Committed - This is the total of commitment from unsupplied sales orders plus 

commitments from other orders such as works orders (components) if used. 

• Uncommitted - This is computed as On Hand – Committed. 

• Back Order - This is the sum of back ordered quantities in sales orders.  By definition Back 

Orders are also Unsupplied (Committed). 

• Available - This is computed as Uncommitted + Back Order. Some users may wish to 

consider Back Orders as a designation to be supplied from future (incoming) rather than On 

Hand stock. Use the Available quantity if you wish to exclude Back Ordered quantity from 

unsupplied when comparing commitment to On Hand stock. 

• Incoming - This is the sum of uncosted (unreceived) Purchase Orders plus any anticipated 

manufacture from works orders (output item). 

• Free - This is computed as Available + Incoming. It indicates the future stock position that 

would occur if all outstanding orders were supplied (Sales Orders) made (Works Orders) or 

received (Purchase Orders) assuming no new orders were created. 

The bottom row shows summary information for sales orders for this item.  Depending on active profiles, it 
also shows a breakdown of committed quantities progressing along the workflow towards supply. 

• Ordered - This is the quantity ordered.  It includes any correction quantity that represents 

an adjustment from the original order quantity placed.  Corrections could occur as entered 

adjustments or can be computer generated to account for oversupply, or for short supply 

determined by forcing the order to fully processed when there is unsupplied quantity. 

• Supplied - This is the total quantity supplied (i.e. stock transactions have been written and 

On Hand has been reduced). 

• Unsupplied - This is computed as Ordered – Supplied.  Note that this can differ from 

Committed on the top row as it excludes commitment from other order types such as Works 

Orders (i.e. excludes W/O component commitment). 

• Back Order - This is the sum of Back Order quantity from Sales Orders.  It is the same 

figure as displays in the top row and is repeated here to portray the correct horizontal 

arithmetic. This figure will be hidden if it zero and the profile Sales Order Back Order 

Quantity Enabled is changed to false. 

• Unreleased - This quantity is usually hidden. It is the portion of unsupplied sales orders that 

are neither Back Ordered nor Released.  This computed quantity can only become non-zero 

if the profile Sales Order Release Back Order Qty Relationship Enforced is changed to 

false.  By default that profile is set to true meaning that anything not Back Ordered is 

automatically Released. 

• In Release - This is the portion of the total Released quantity that has not yet been supplied / 

supplying (or picked if picking profile enabled). 

• In Pick - This quantity is usually hidden. It is the portion of the Picked quantities from sales 

orders that are not yet supplied or in supply. Picking requires the profile Sales Order Pick 

quantity Enabled to be set true. 

• In Supply - This is quantity that has been scheduled for supply but has not been processed 

to stock transactions yet. It is necessary to distinguish this from Supplied (shown in the left 

hand side of the line) as On Hand stock has not yet been consumed.  In supply is also 

included in Unsupplied (and Committed) until processed. 
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5. Message bar 

The status bar at the bottom of the screen will displays a message for any cell that has an invalid entry. 
Batch Sales Order Line Processing constrains the maximum value of any quantity type to the quantity that 
precedes it in the processing cycle (for example, it will not permit release of more than ordered or cannot 
invoice more than supplied). 

Note: When the line has a negative order quantity (a return or credit) Distribution Advantage 
performs the appropriate comparisons by using absolute values. 

Distribution Advantage will validate for constraints and any invalid entries will turn the background colour 
of the invalid cell to red and change the OK column to N (also goes red). The batch cannot be processed 
whist any line displays an error condition. When a cell with error condition receives the keyboard focus, the 
relevant error message will be displayed in the status bar at the bottom of the screen. 

 

In this example the released quantity has been changed from 5 to 6 and now exceeds the ordered quantity. 
To rectify this situation either reduce the released quantity or increase the ordered quantity (i.e. 
oversupply). 

Changing the Order quantity in this grid preserves the original quantity that was ordered via Sales Orders in 
Exo Business and records any difference as a Correction quantity. The figure shown here is always the 
Corrected quantity. 

Using the Sales Order Line Details Grid 

The grid shows sales order lines. The selection criteria used to create the batch may have included only 
selected lines for a given sales order; complete orders may not necessarily be included in the batch. 

The order number and stock code identifies the line. 

The grid may be sorted by clicking one or more column headings. This sequence provides the method to 
prioritise the allocation of stock when using the toolbar buttons to set quantities. 

A number of line functions are available by right-clicking a row in the grid. 

Function Meaning 

Show Stock 
Levels 

This shows a multiple locations grid for the stock item of the row in focus. 
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This can be used to ascertain stock levels in locations other than the location for 
this line. Other stock level information for the single location of this line is 
available in the panel at the bottom of the screen. 

Drill to This provides sub menu items to drill to the Debtor account, Stock item or Sales 
Order associated with this row. 

Drilling can also be achieved by double clicking the Order No, Acc or Stock Code 
fields in a row. 

Add (Edit) Narra
tive 

This allows either the order line or order header narrative associated with this 
row to be added or amended. 

When a line level narrative exists the   icon displays on the stock status bar. 

Release Line 
Pick Line 
Supply Line 
Invoice Line 
Reset Line 

These menu items all functions that set (or clear) quantities. They are the line 
level equivalents of the batch level functions available from the toolbar. Unlike 
the toolbar buttons these menu functions only alter quantities for the row in 
focus. The submenus match the dropdown menus of those buttons. Please see 
the following Using the toolbar section for a more detailed description of these 
functions. 

Using the Toolbar 

 

The toolbar has the following buttons: 

Button Meaning 

Close Closes the BSOLP batch screen. Changes are updated to the database as focus moves off 
each cell there are no separate Save or Cancel buttons. Use the Close button to suspend 
your work for later recall and Process. 
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Refresh Lines are automatically refreshed as they are scrolled. Optionally use this button to refresh 
the whole grid. Refresh is usually only relevant when displaying some of the additional 
columns available. The Refresh button re-compares the details of the batch against the live 
sales orders and updates the display of any differences. The screen can be set to 
automatically refresh at a specified interval in the Details>Setup Refresh Interval menu 
item. When the auto-refresh function is active, the icon on the button will have a dot in 
the centre. 

 

Toggles the display of stock information at the bottom of the screen. 

Release The actions available from the down arrow to the immediate right of the button are: 

• Release On Hand - Release quantities are set until on hand stock becomes 
exhausted. 

• Release Uncommitted - Release quantities are set until uncommitted stock 
becomes exhausted. 

• Release Available - Release quantities are set until available stock becomes 
exhausted. 

• Release Free Stock - Release quantities are set until free stock becomes exhausted. 

• Release All - Release quantities are set unconditionally to ordered for the line. 

• Release as per Supply – Sets the release quantity equal to the supply quantity. This 
is the inverse of the Supply as per Release function of the Supply button. 

Release may possibly also make a contra adjustment to the backorder quantity. If the 
Release quantity is increased sufficiently that: 

Released + Backordered > Ordered 

then the backordered quantity will be reduced to compensate. This will always occur if the 
profile Sales Order Release Back Order Qty Relationship Enforced is true (default). 

The Release button is disabled if the profile setting Sales Orders Release Quantity Enabled 
is false (default). 

Pick The actions available here are: 

• Pick On Hand - Pick quantities are set until on hand stock becomes exhausted. 

• Pick Uncommitted - Pick quantities are set until uncommitted stock becomes 
exhausted. 

• Pick Available - Pick quantities are set until available stock becomes exhausted. 

• Pick Free Stock - Pick quantities are set until free stock becomes exhausted. 

• Pick All - Pick quantities are set unconditionally to ordered for the line. 

• Pick as per Release - Sets the pick quantity equal to the release quantity. 

 The Pick button is disabled if the profile setting Sales Order Pick Quantity Enabled is false 
(default). 

Supply The actions available here are: 

• Supply On Hand - Pick quantities are set until on hand stock becomes exhausted. 
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• Supply Uncommitted - Pick quantities are set until uncommitted stock becomes 
exhausted. 

• Supply Available - Pick quantities are set until available stock becomes exhausted. 

• Supply Free Stock - Pick quantities are set until free stock becomes exhausted. 

• Supply All - Supply quantities are set unconditionally to ordered for the line. 

• Supply as per Pick – Sets the supply quantity equal to the picked quantity. 

• Supply as per Release – Sets the supply quantity equal to the release quantity. This 
is the inverse of the Release as per Supply function of the Release button. 

Invoice The functions available here are: 

• Invoice On Hand - Invoice quantities are set until on hand stock becomes 
exhausted. 

• Invoice Uncommitted - Invoice quantities are set until uncommitted stock 
becomes exhausted. 

• Invoice Available - Invoice quantities are set until available stock becomes 
exhausted. 

• Invoice Free Stock - Invoice quantities are set until free stock becomes exhausted. 

• Invoice All - Invoice quantities are set unconditionally to ordered for the line. 

• Invoice as per Supply – Sets the invoice quantity equal to the picked quantity. 

Process This button processes the Sales Orders. 

The Release, Pick, Supply and Invoice buttons offer actions to allow the quantities to be set (on the entire 
grid) for a normal workflow. These can set (or clear) quantities. Various calculations are available using 
different figures from the stock levels information or from a preceding quantity type (for example, Invoice 
as supplied). Each button has a choice of actions from their dropdown menus. Pressing the button (without 
dropdown) takes the default action from the dropdown list. The default action will depend on the stock 
quantity type presently selected at the right of the stock status bar. The tool tip will also indicate the 
default action. When selected from the toolbar, all actions will display a confirmation dialogue before 
proceeding. 

These actions can also optionally be pre-programmed into the Task definition to occur at the time a batch is 
created. The default stock quantity type for the stock status bar is always defined by the Task but may be 
changed at run time. 

When calculating from stock levels precedence of the sales order lines can be controlled by using the grid 
sorting function. The grid is processed from top to bottom. 

Using the Menu bar 

The menu bar has the usual File, Navigate and Help menus. When inside a batch, the Details menu contains 
the following options: 

Option Meaning 

Refresh Refreshes the display 

Setup Refresh 
Interval 

Allows the auto refresh capability to be activated or deactivated and sets the 
refresh interval when active. 
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Reset Resets data 

Update Locks 

Update Locks 
Silent 

While a Batch Sales Order Line Processing batch is open, the Sales Orders in the 
batch are locked and cannot be edited by another user. 

These functions recheck the lock conditions to see if they have been relinquished 
and the batch can take possession of the lock. 

Managing Sales Order Batches 

You can suspend a session for later recall by clicking the Close button. While a sales order line is owned by 
an unprocessed batch it is tagged with the batch number. This prevents it being processed using another 
Exo Business function or being added to another Batch Sales Order Line Processing batch. This is true for 
both suspended (closed) batches, as well as one currently open on a workstation. 

Loading an Existing Batch 

A batch may be suspended without processing by clicking the Close button and then recalled for further 
amendment or processing. Processed batches that were not deleted after processing may also appear but 
can only be opened for viewing. 

When first opened, the Batch Sales Order Line Processing function displays a grid of batch headers, 
including previous batches. 

 

Double click the desired batch to open it and continue editing. 

Deleting an Existing Batch 

If a batch is no longer required, it may be deleted from Distribution Advantage. This includes batches that 
were suspended or not deleted after processing. Deleting a suspended batch returns the Sales Order lines 
to the un-batched pool. Any unprocessed quantities remain in the Sales Order line pending processing as 
part of another future batch or if processing the Sales Orders as part of another workflow. 

To delete an existing batch, select the desired batch and click the  button. 

Processing a Sales Order Batch 

It is normal practice to process a batch once the desired result is obtained within the grid.   
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A session may also be suspended for later recall using the Close button. Note that there is no Save or 
Cancel button, as all changes are updated to the Sales Order lines interactively. While a Sales Order line is 
"owned" by an unprocessed batch it is tagged with the batch number. This prevents it being processed 
using another Exo Business function or being added to another batch. This holds true for both suspended 
(Closed) batches, as well as one currently open on a workstation. 

Once a batch is processed it may not be altered or processed a second time. If you are separating workflow 
steps (for example, separate supply and invoice phases), another Task definition should be used to create a 
new batch for the next phase. 

To process a batch: 

1. Click the Process button. Distribution Advantage displays a confirmation message showing the 
process and print functions that will be performed. These are predefined for each Task but may be 
changed if required. 

 

2. Click OK to proceed. Distribution Advantage will re-verify the quantities present are OK and process 
them against the sales orders. Documents will be printed as Distribution Advantage detects each 
sales order boundary during processing. 

3. At the conclusion of processing the you are prompted to delete the batch details. 

 

It is normal practice to delete batches once processed, however they can be retained, possibly for 
subsequent reporting, and then deleted via the BSOLP batch header search grid later. Sales order 
lines from a completed batch are always relinquished from the control of that batch so may then 
be added to a new subsequent batch. 

o Click Yes to delete the batch. This only deletes the batching information and does 
not delete the sales order lines. 

o Click No to retain the batch information. A batch retained after processing is 
protected from being edited or processed again. 
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Batch Sales Order Line Processing Command Line Options 

You can start the batch creation using command line parameters by adding: 

• A menu function within another application. 

• A custom button to another process within another application. 

• Menu parameters to an instance of the Batch Sales Order Line Processing menu item within 

the Distribution Advantage application. 

The command line parameters are: 

DA.exe <login> BP /TASK=<task number> 

Where <integer> is the internal task number shown on the task setup header bar – for example, /TASK=13. 

For the individual sales order method of creating a batch, use: 

DA.exe <login> BP /SO=<order number> 

When using command line options with a menu in Distribution Advantage, use the menu item with this 
parameter: 

/TASK=<task number> 
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Stock Transfer Requests 

Stock Transfer Requests provides enhanced stock movement transactions when: 

• Stock transfers require a "request then send" process 

• Transferred stock is in transit for a period of time, such as when being transferred via 

courier, and this needs to be managed 

Two types of transfers are available: Immediate Stock Transfers and Stock Transfer Requests. 

Stock Transfer Request Setup 

Stock transfer requests require some setup before use. Profile settings determine overall options, and 
Stock Transfer Types are used to record the type of requests being used. 

Profiles 

Some system profiles should be set to configure the transfer program accordingly: 

• Stock request transfer transit location - Specify the intermediate stock location for goods 

in transit when using Stock Requests for transfers. 

• Stock request transfer percentage warning - Specify a percentage for the minimum stock 

to be left in the From location when using Stock Requests for transfers. This does not 

restrict the transfer quantity but generates an alert when attempting to deplete stock below 

this level. 

• Stock request transfer quantity warning - Specify a quantity for the minimum stock to be 

left in the From location when using Stock Requests for transfers. This does not restrict the 

transfer quantity but generates an alert when attempting to deplete stock below this level. 

• Suppress Save then Send - This profile hides the Save then Send option on transfers, which 

may be useful in some sites to avoid accidentally sending stock requests. 

Stock Request Types 

Stock Request Types are used to indicate and record the type of request required by the user. They are set 
up in the Exo Business Configuration Assistant at Administration > Courier > Stock Request Types. 

Immediate Stock Transfers 

Immediate Stock Transfers are used to perform an immediate, one-step transfer of stock between two 
locations, and print a matching transfer document. This type of transfer does not use an in-transit location. 

To perform a quick transfer: 

1. Select Stock Immediate Transfer from the Transactions menu. This screen displays: 
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2. Click the New button to begin a transfer. 

3. Specify the staff member performing the transfer in the By field. 

4. Enter the From location and To location. 

A warning displays if the From or To location is the same as the in-transit location. You can ignore 
the warning, but take care when directly transferring to or from the in-transit stock location. 

5. Enter a date in the Required field, to notify the other party of the date required. 

6. Enter any relevant notes in the Notes field. 

7. In the main grid, enter the required stock code, or enter ? and press TAB to open the stock item 
search window. Enter the requested quantity, and any comments for the stock line. 

8. When all the items are entered, press the Process button to proceed. This message displays: 

 

9. To print a copy of the Stock Transfer Request from, click Yes. 
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Making Stock Transfer Requests 

Stock Transfer Requests are used to perform a multi-step transfer of stock between two locations, including 
a time in transit. The request follows a request-dispatch-receipt type process. Supporting transfer 
documents may also be printed. 

This function also supports a To-Do list for warehouses to monitor what transfers are awaiting dispatch 
from their warehouse. 

Stock Transfer requests can have these statuses: 

• New Request – a new request entered, waiting processing and sending by the From 

location. 

• Picking – The request has been saved, and locked ready to pick. However it has not been 

processed or dispatched yet. 

• In Transit – a request that has been processed by the From location, and is transferred to the 

in-transit stock location 

• Complete – a request that have been received and processed by the To location, and is now 

complete. 

Select Stock Transfer Request from the Transactions menu. The following screen displays: 

 

You can: 

• Enter requests 

• Review requests, filtering by status or location or searching by a specific request number 

• Process outstanding requests by location 
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Entering a Request 

To enter a request: 

1. Click the New button to begin a transfer. 

 

2. Specify the staff member performing the transfer in the By field. 

3. Enter the From location and To location as appropriate. A warning will be given if the From or To 
location is the same as the ‘in-transit’ location. While this warning can be ignored, care should be 
taken with directly transferring to or from the in-transit stock location. 

4. Enter a date in the Required field, to notify the other party of the date required. 

5. Enter any relevant notes in the Notes field. 

6. In the main grid, enter the required stock code, or enter ? and press TAB to open the stock item 
search window. Enter the requested quantity, and any comments for the stock line as required. 

7. When all the items are entered, three options are available: 

• Save - saves the transfer with the status of "New Request", but does not close the 
transfer. This will allocate a request number, and allow transfer documents to be 
printed, using the Print button on the toolbar. 

• Save and Exit - saves the transfer with the status of "New Request", and returns to 
the main Stock Transfer Request window. This sets the request ready to be 
processed from the From location. 

• Save then Send - this is used when the transfer is to be directly entered by the 
From location and sent immediately. That is, the request is entered and sent 
immediately by the user in the same location. 
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Reviewing Requests 

From the main Stock Transfer Request screen, you can review stock transfer requests. The list of transfers 
may be filtered or searched. 

To filter transfer requests by location, select one of the options under Location: 

• Select All to view transfers for all locations 

• Select the From (or to) option and enter a specific location to restrict the list to only those 

involving that location. This will list transfers regardless of the request being from or to the 

specified location. 

• Select the Route (from – to) option and enter the specific From and To locations that are 

used in the transfer to list only transfers taking place between these locations. 

To filter transfer requests by status, select the relevant check box(es) under Stock Request Status. 

To search for a specific transfer request, enter a request number in the Request No. box and click Search. 

From the list of transfer requests, you can: 

• View the transfer notes on a specific entry by clicking a line. (The Notes pane can be turned 

on and off by selecting the Show and Hide Notes option in the File menu or clicking the  

button). 

• Refresh the list of items by selecting Refresh from the File menu or clicking the   button. 

The Stock Transfer Request window can be left open to monitor stock requests to be 

processed for a specific location. In this instance, click the Refresh button periodically to 

ensure the list is current. 

• Process a request by double clicking on an entry. 

Processing Requests 

Stock Transfer Requests follow the Request-Dispatch-Receipt process. Once requests have been entered, 
the transfer needs to be processed to the next stage. 

To process a request, double click on the selected request. 

Once open, the request can be processed to the next stage. Depending on the last state the request was in 
when saved, the available toolbars buttons will differ to provide the appropriate function: 

• If the request was saved without being sent, the Send button will be available. 

• If the request has been saved and sent, the Process button will be available. 

• If the request has been sent and processed, the Receive button will be available. 
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Sales Order Consolidation 

The Sales Order Consolidation function assists with handling Sales Orders at a line level. It can be used with 
the Batch Sales Order Line Processing function. 

While Batch Sales Order Line Processing allows separate treatment of Sales Order lines for processing at 
each stage of the delivery cycle it has no ability for resulting documents (for example, packing slips, Invoices 
and the like) to span the boundary of each original order number. In an organisation where individual 
customers place frequent orders it becomes likely that products for multiple Sales Orders are shipped 
simultaneously to a customer. There are often gains to be achieved by consolidating lines from individual 
orders for a customer to single consolidated Sales Order for shipping and subsequent invoicing. 

Such a business process requires validation of stock before dispatch so that consolidation does not occur 
for Sales Order lines where stock is physically unavailable. Exo Business provides for signalling confirmation 
of stock to the database using the optional Picking capability of the software. This allows you to enter 
quantities for stock physically picked (before dispatch) as a confirmation that the stock is physically 
available. Typically at this point the stock has been physically removed from the pick face and placed in a 
carton, pick tray (or similar) marked for that customer. 

To accommodate split quantities (multiple deliveries) per line, the consolidation process relies on the 
calculation picked, which is supplied when identifying lines as candidates for consolidation. Additional 
filters may be applied to limit candidate orders by other factors for example, location, branch, customer, 
and the like. The choices are similar to the Batch Sales Order Line Processing process using the same Task 
Setup function. 

With consolidated orders it is important to identify, for each line, the source origin of the line. This is done 
from a customer perspective and hence uses the Customer Order Number (usually corresponds to the 
customers own purchase order number). Each consolidated line has a line level customer order number 
field set to that of the header of the originating order. Non-consolidated orders leave the line level 
reference blank.   

It is anticipated that customisation of Clarity documents for packing slips, invoices and the like will be 
undertaken by the implementer to conditionally print line level references where non-blank (informing the 
customer of the origination order number). Where no customer reference was supplied (i.e. left blank) the 
consolidation process will generate one for the consolidated lines (contains internal Sales Order number) 

Prerequisites 

Picking must be active and used in Sales Orders, i.e. the Company profile setting Enable sales order pick 
quantity must be set true. 

Workflow processes for a picking phase in the dispatch cycle must also be implemented. 

Workflow summary 

The following describes a typical workflow surrounding the consolidation process and shows how it may be 
used with Batch Sales Order Line Processing.  Functions performed by Batch Sales Order Line Processing in 
this example could also be manually processed on an individual order basis. 

1. Orders are collected and entered in the normal way. 

2. Batch Sales Order Line Processing is used to create a batch of (unconsolidated) order lines in which 
Release quantities are activated for allocation of stock 

3. Picking slips printed as instruction to the warehouse. 

4. Picked quantities are entered and processed (possibly by the warehouse staff) as stock is physically 
verified. 
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5. The Sales Order Consolidation process is run to select picked (but unsupplied) quantities and 
move/split these to consolidated orders grouped by customer code. This requires election of a pre-
defined task to activate any filtering that might be required (similar to Batch Sales Order Line 
Processing). 

• The output is a modified set of Sales Orders. 

• The Sales Order history data is updated for the contributing orders with a new event class 
to indicate consolidation has occurred (and quantity moved). 

• The released and picked quantities of the contributing lines are reduced by the picked 
quantity moved and the correction quantity of those lines is updated with the same figure 
to indicate that the order requirement has been downgraded (shifted to other order lines). 
Note that if the picked quantity is less that the released quantity then the residual released 
but not picked quantity remains in the original line. 

6. The Batch Sales Order Line Processing process created another batch of picked but unsupplied so as 
to process the supply and invoice of the picked but unsupplied orders (including the consolidated 
ones). 

• Packing slips (from supply quantity) and/or Invoices (from invoice quantity) are produced at 
this point. Paperwork produced will need to be matched with the already picked stock 
before dispatch. 

• Note that this is a fresh batch with its own task (selection criteria) and could potentially 
include a differing set of lines from that processed in the consolidation run including 
unconsolidated orders and output from multiple consolidation runs. 

Limitations 

Not all features of Exo Business are supported by the Sales Order Consolidation function. Exceptions are 
detailed below. 

Workflow timing 

The consolidation function processes quantity which is picked but not supplied. 

• The picked quantities must be processed (not just entered) before consolidation will occur. 

• Supply quantities may optionally have been entered but must not have been processed (i.e. 
quantity which is already part of a Stock transaction will not be consolidated). Any previously 
processed supply quantity will remain with the original order 

These business rules permit multiple dispatch cycles to have occurred for any given line, but only 
unsupplied goods will be consolidated. These business rules preclude the consolidation phase being 
between supply and invoice phases. 

Amalgamation 

Lines for identical products do not amalgamate to a single line per product in the consolidated order. Each 
line may carry a unique customer reference that must be retained. 

When grouping orders the parent /child nature of head office accounts is ignored. Orders for child accounts 
will amalgamate separately as it they were non-child accounts rather than all child accounts being 
amalgamated to a single order for head office. This retains reporting integrity for sales analysis purposes. 

Stock Batch and Serial numbers 

Stock batch codes will travel with the line as it moves to the consolidated order. This is achievable as there 
can only be one batch code per Sales Order line. 
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Serial numbers are not processed by the consolidation process. It is not practical to identify which serials of 
those that may have been pre-assigned should be selected for moving to the consolidated order. 

There may also be other serials tagged to the Sales Order which are already supplied (associated with the 
Stock Transactions that depleted them from stock). As supplied quantity is never moved to the 
consolidated order the serials for this line which are no longer in stock are not an impediment for 
consolidation. Only pre-assignment is an impediment. 

Credits 

Sales orders which have a negative order quantity will eventually result in stock inward and a credit note. 
Distribution Advantage has been designed to ignore such orders in the consolidation process. It is 
considered that amalgamation of credit orders would likely defeat business controls associated with the 
return of goods. 

Setting Up Tasks for Sales Order Consolidation 

One predefined task is supplied for use with the Sales Order Consolidation process. This task has no 
selection criteria.  If additional tasks are required containing selection criteria, they may be set up using the 
Setup Batch Task window from the Batch Sales Order Line Processing function. 

The differences apply when using Tasks with Sales Order Consolidation: 

• Set the Apply to property to "Order Consolidation". 

• Step 3 of the Task Wizard (Select Sales Order Lines) is not relevant for consolidation and 

this setting is ignored. 

• The Actions tab is not relevant for consolidation and any settings are ignored. 

• The Process Defaults tab is not relevant for consolidation and any settings are ignored. 

Consolidating Sales Orders 

To use the Sales Order Consolidation feature: 

1. Select the Sales Order Consolidation menu item. 
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2. Click the New button to display tasks which have the Apply to property set to Order Consolidation. 

 

3. Select a task and click Select and Close to create a set of orders. 
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4. To consolidate the selected orders, click Process. 

5. A summary screen displays. You can print the screen. 

 

If you have multiple tasks defined, click New and select another task with different selection criteria. 

Sales Order Consolidation Command Line Options 

Sales Order Consolidation can be invoked by the use of command line parameters. This can be done in a 
number of ways. 
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• By adding a menu function within another application. 

• By adding a custom button to another process within another application. 

• By adding menu parameters to an instance of the Sales Order Consolidation menu item 

within the Distribution Advantage application. 

The third case differs from the other two as it may be used within a running instance of the Distribution 
Advantage application without creating another instance of the application. This effectively moves the task 
selection list to the DA base menu allowing a new batch to be created directly from the menu. 

Either of the first two cases may be used with to create a batch from within another application (for 
example, from the Exo Business core application or Exo Business Sales Orders). 

The command line parameters in these cases are of the form: 

DA.exe <login> SC /TASK=<task number> 

Where <integer> is the internal task number shown on the task setup header bar. for example, in the 
following instance use : 

/TASK=18 

When using within the menu of DA itself use the Sales Order Consolidation menu item with parameters of 
the form: 

/TASK=<task number> 
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Distribution Advantage - Advanced Setup 

Used these profile settings to configure the Distribution Advantage module. 

Company Profile Settings 

Enforce sales order quantity constraints - Constrains Sales Order quantities to a maximum of their 
preceding type — for example, restricting invoice quantity to supply quantity. 

Enforce constraint of sales order quantity ad release quantity + backorder quantity - Select to constrain 
the unsupplied quantity to be either Released or Back Ordered (Order Qty = Release Qty + Back Order Qty) 

Enable sales order back order quantity  Select to use the back order quantity feature on Sales Orders and 
permit manual control of the back order quantity from Sales Order entry. When this profile is inactive, a 
quantity can still appear in the calculated field Unsupplied.  Activating this profile allows differentiation of 
the unsupplied quantity into Back Ordered and non-Back Ordered. 

Enable sales order pick quantity - Select to use the pick quantity feature on Sales Orders and permit 
manual control of the picking quantity from Sales Order entry. This is an additional phase preceding supply 
and does not alter stock levels. If picking is enabled then pre-assignment of serial numbers also constitutes 
picking and updates picked quantities. 

Enable sales orders release quantity - Select to use the release quantity feature on Sales Orders to 
manually control supplied quantity from Sales Order entry. For example, for stock rationing 

Stock request transfer quantity warning - Specify a quantity for the minimum stock to be left in the From 
location when using Stock Requests for transfers. This does not restrict the transfer quantity but generates 
an alert when attempting to deplete stock below this level. 

Stock request transfer percentage warning - Specify a percentage for the minimum stock to be left in the 
From location when using Stock Requests for transfers. This does not restrict the transfer quantity but 
generates an alert when attempting to deplete stock below this level. 

Intermediate stock location for goods in transit - Specify the intermediate stock location for goods in 
transit when using Stock Requests for transfers. 

User Profile Settings 

Constrain stock request transfer processing - Constrain stock request transfer processing to only process 
stock transactions (process send or receive) from/to users default location or the in-transit location. 

Stock request transfer suppress 'save then send' - Hide the Save then Send button on the Stock Transfer 
Request window. 
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